


Important safety warnings follow.
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Available Options
� Copy
� E-mail
� Scan to Network
� Scan to Mailbox

Access Control Feature
Access Control requires you to enter a 
password before using the scanner. If 
your administrator has enabled Access 
Control, use the scanner panel�s 
number keys (1) to enter your 
assigned PIN, then press [Login]:

Important! When you are done, be 
sure to press [Logout]  to return the 
scanner to the PIN entry screen.
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Walk-Up Operation
The Scanner Control Panel
� T

ES3640e MFP 64.jpg

Touch Screen
Tilt feature:
� a = Release Button
� b = Handle

Scan Functions
� COPY
� SCAN TO E-MAIL
� SCAN TO NETWORK 
� SCAN TO MAILBOX
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Walk-Up Operation
The Scanner Control Panel
Control Keys
� INTERRUPT = Press to interrupt a 

print job, in order to scan a 
document.

� POWER SAVE = Switches scanner 
power save mode on/off.

� HELP = Displays help information 
on touch screen.

� SETUP = Switches to Setup mode 
for entering e-mail addresses, etc.

Numeric Keypad
� 0 to 9 = enter numbers.
� Decimal Point = enter decimal 

values or periods.

� Clear ( ) = deletes all text in the 
selected box on the touch screen.

START
Begins selected operation.

STOP
Stops operation in progress.

RESET
Resets scanner settings to defaults.

LEDs
POWER = Scanner is on.
ATTENTION = Scanner or printer: out 
of paper, paper jam, etc.
5



Walk-Up Operation
The Scanner Control Panel
Touch Screen Image Adjustment
Sets brightness, contrast, image 
position, etc.

1.  : Enter adjustment mode.

2.  and   : Page through 
items around perimeter of 
Adjustment box.

3.  : Engage the selected item. 
Value bar changes from black to 
red.

4.  and   : Change value.

5.  : Engage the new value. Value 
bar changes from red to black.

6. Repeat previous two steps until all 
changes are made.

7.  and   : Move to EXIT.

8.  : Exit.
6



Walk-Up Operation
Using the Scanner/Copier
Loading a document
Automatic Document Feed (ADF)
� Up to 50 sheets: no staples, clips, 

or ragged edges.
� Document size: min. 5.5" x 8.5", 

max. 11" x 17"
� Weight Range: 16 to 28 lb. (60 to 

106 g/m²).
� Load documents face up, with top 

edge entering scanner.

Scanner Glass
� Individual sheets
� Document size: min. 5.5" x 8.5", 

max. 11.8" x 17"
� Weight: any. Leave lid open to scan 

pages in books.
� Load documents face down, with 

top edge facing left and placed 
against back rear corner of the 
scanner glass.
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Walk-Up Operation
Using the Scanner/Copier
For more information, see the User�s 
Guide on the Documentation CD 
provided with your system or at 
http://my.okidata.com.

To Make Copies
Note: The �Copy Mode� window is 

the default which appears on 
the Touch Screen. To switch 
from another active mode to 
Copy Mode, press the COPY 
key.

1. Load the document to be copied.
2.Use the number keys to select the 

number of copies (up to 999).
3.Make any other settings you need 

on the Touch Screen tabs: [Basic 
Settings], [Details], [Image 
Quality], [Finishing].

4. Press the START key.

To Scan and E-mail
1. Load the document to be scanned.
2. Press the SCAN TO E-MAIL key. 

The �E-Mail Send Mode� window 
appears on the Touch Screen.

3.Touch the appropriate button 
under [Address Source] and select 
or key in the e-mail address, then 
click [OK]

4.Make any needed changes in the 
settings on the [Address], 
[Message Text] and [Attachments] 
tabs.

5. Press the START key.
8



Walk-Up Operation
Using the Scanner/Copier
To Scan to an FTP Site
1. Load the document to be scanned.
2. Press the SCAN TO NETWORK key. 

The �Network Send Mode� window 
appears on the Touch Screen.

3.On the [FTP Server] tab, touch the 
appropriate button under [Address 
Source] and enter the [FTP Server 
Name], then touch [OK].

4.Make any needed changes in the 
settings on the [FTP Server] and 
[Attachments] tabs.

5. Press the START key.

To Scan to a Mailbox
1. Load the document to be scanned.
2. Press the SCAN TO MAILBOX key.  

The �Mailbox Send Mode� window 
appears on the Touch Screen.

3.Touch the appropriate button 
under [Address Source], then 
follow the on-screen prompts to 
enter the mail box name.

4.Make any needed changes in the 
settings on the [Mailbox] and 
[Attachments] tabs.

5. Press the START key.
9



Walk-Up Operation
Using the Scanner/Copier
To Scan to a Hold Queue
1. Load the document to be scanned.
2. Press the SCAN TO MAILBOX key. 

The �Mailbox Send Mode� window 
appears on the Touch Screen. 

3. Touch [Hold Queue].
4. Enter your settings on the [Hold 

Queue] and [Attachments] tabs.
5. Press the START key.

Clearing a Scanner Paper 
Jam

1.Press the release button (1) and 
lift the ADF feed cover (2).

2. Pull out the sheet (3).
3.Close the ADF feed cover.

ES3640e MFP 71.jpg
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Replacement Supplies
Purchasing Information
Purchasing Information
Where to Purchase
Consult the dealer where you 
purchased your system.

Part Numbers
Toner Cartridges 

Color OKI Part #
Black ............................... 42918924
Cyan................................ 42918923
Magenta ........................... 42918922
Yellow .............................. 42918921

C96_Toner.jpg
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Replacement Supplies
Purchasing Information
Image Drums

Color OKI #
Black ............................... 42918120
Cyan................................ 42918119
Magenta ........................... 42918118
Yellow .............................. 42918117

Other Consumables

Consumable Oki #
Fuser ( )............... 57102201, 120V
                 ............. 57102202, 230V
Transfer Belt ( ).............. 57102301
Toner Waste Bottle............. 57102401

C96_Drum.jpg

C96_Fuser.jpg
C96_belt crop.jpg
1f.tif, 2f.tif
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The Printer Menu
Changing Settings
1. Press ENTER to switch to the menu 
mode.

2.Use the ∇ key to scroll down to the 
Function you wish to change.

3. Press ENTER.

4.Use the ∇,  ∆  and ENTER keys to 
drill down to the item you wish to 
change.

5.Use the ∇/ ∆ keys to move to the 
setting you wish to engage.

6. Press ENTER.
An asterisk appears next to the 
new setting.

7. Press ON LINE to exit the Menu 
mode.

C96_ReadyToPrint.jpg

C98_Functio
ns_Menu_a.j
pg
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Menu

The Printer Menu
Structure
For more information, see the on-line 
User's Guide on the Docu-mentation 
CD provided with your printer or at 
http://my.okidata.com.

� Configuration
� Page Count, Supplies Life.
� Network and System Settings.
� Size of paper automatically 

detected in feed tray.
� Print Pages

� PS Test Page, Configuration.
� Job Log, Color Charts.
� PS and PCL font lists.
� Print Demo Page.
� E-mail and Error lists.

� Suspend Printing

� Resume Printing

� Print Secure Job (Password 
Protected)
� Print out documents from the 

HDD.

� Menus
� Set the size, weight and type of 

media for the various feed trays.
� Adjust system settings.

� Shut Down

� Admin Setup
� Server and Network Setup.
� Parallel and USB Setup.
� Printer Setup.
� PS and PCL Setup.
� Color and Job Log Setup.
� Change Password.
� Set display language.
� Reset to Factory Defaults.

� Calibration
� Density adjustments, 

Registration.
� Set calibration.

� Print Statistics (Password 
Protected)
14



Print Media Settings
Changing
Why Change?
Wrong media settings can cause:
� poor quality printing
� flaking
� damage to the printer

Media Weight
The default media weight setting for 
all trays is AUTO.

Individual Print Jobs
If you are using special media for only 
one print job, you can adjust the 
media settings in the driver.  Load the 
media in the appropriate tray (usually 
the MP tray). In your application, click 
[File] → [Print] and adjust the media 
settings as necessary.

All Print Jobs (Defaults) 

1.Press ENTER.
2. ∇/ ∆ keys → Menus.  Press ENTER.
3.With Tray Configuration highlighted, 

press ENTER.
4. ∇/ ∆ keys → tray to be configured. 

Press ENTER.
5.Use ∇,  ∆ and ENTER to scroll 

through the submenus and to 
make your setting changes.

6. Press ON LINE to exit the Menu 
mode.

Control Panel 
Right Side.jpg
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Print Media Settings
Changing
Reset to Factory Defaults 

1. Press ENTER.
2.Use the ∇  key to scroll down to 

Admin Setup. Press ENTER.
3. ∇/ ∆ keys → Yes. Press ENTER.

Offline appears on the display
4.Wait for setup to run.

The Setup menu appears.
5. ∇/ ∆ keys → Factory Defaults. Press 

ENTER.
6. ∇/ ∆ keys → Yes. Press ENTER.

The printer resets. Shutting down 
appears on the display.

7.  When the printer finishes shutting 
down, press SHUT DOWN /
RESTART.

Control panel HRef Set1.jpg
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Print Media Settings
Weight
US Bond
Select the appropriate settings in either the printer menu or in the printer 
driver.
Printer driver settings override printer menu settings. 

Setting US Bond (metric)

Auto (default) 17 to 57 lb. (64 to 216 g/m2)

Light 17 lb. (64 g/m2)

Medium Light 18 to 19 lb. (68 to 71 g/m2)

Medium 20 to 24 lb. (75 to 90 g/m2)

Medium Heavy 25 to 28 lb. (94 to 105 g/m2)

Heavy 29 to 34 lb. (109 to 128 g/m2)

Ultra heavy 1 35 to 50 lb. (132 to 188 g/m2)

Ultra heavy 2 51 to 58 lb. (192 to 218 g/m2)

Ultra heavy 3 [MP Tray only] 59 to 80 lb. (222 to 301g/m2)
17



Print Media Settings
Weight
Index

Note: To determine if a paper weight is US Bond or Index, check the metric 
equivalent. Example: 35 lb. US Bond = 132 g/m2; 35 lb. 
Index = 64 g/m2.

For more information, go to www.paper-paper.com/weight.html.

Setting Index (metric)

Auto (default) 35 to 118.6 lb. (64 to 216 g/m2)

Light 35 lb. (64 g/m2)

Medium Light 37 to 40 lb. (68 to 71 g/m2)

Medium 42 to 50 lb. (75 to 90 g/m2)

Medium Heavy 52 to 56 lb. (94 to 105 g/m2)

Heavy 60 to 71 lb. (109 to 128 g/m2)

Ultra heavy 1 73 to 104 lb. (132 to 188 g/m2)

Ultra heavy 2 106 to 141 lb. (192 to 218 g/m2)

Ultra heavy 3 [MP Tray only] 123 to 166 lb. (222 to 301 g/m2)
18



Print Media Settings
by Paper Tray
Tray 1 

*Important!
� Duplex printing is restricted to paper only, 20 to 32 lb. US Bond.
� If you experience curling with 20 or 24 lb. paper, switch to 28 lb.

Media Weight 17 to 57 lb. US Bond (64 to 216 g/m2)

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)*

Media Size Paper:
� min. 4.1" x 5.8" (105 x 148 mm)
� max. 12" x 18" (305 x 457 mm)
� Custom sizes must be defined in driver before printing.

Transparencies: letter or A4

Takes 550 Sheets 20 lb. (75 g/m2) paper
200 transparencies
19



Print Media Settings
by Paper Tray
Optional Trays
� Optional trays 2 and 3
� Optional 3-Tray High Capacity Feeder. 

Media Weight 17 to 57 lb. US Bond (64 to 216 g/m2)

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)

Media Size Paper:
� min. 5.8" x 8.3" (148 x 210 mm)
� max. 12" x 18" (305 x 457 mm)
� Custom sizes must be defined in driver before printing.

Each Tray Takes 550 Sheets 20 lb. (75 g/m2) paper
No transparencies 
20



Print Media Settings
by Paper Tray
MP (Multi-Purpose) Tray
This is also known as the manual feed tray.  

Media Weight Paper: 17 to 80 lb. US Bond (64 to 301 g/m2), up to 166 lb. Index

Duplexing: 20 to 32 lb. US Bond (75 to 120 g/m2)

Banners: 20 to 34 lb. US Bond (75 to 128 g/m2)

Media Size Paper:
� min. 3" x 5" (76 x 127 mm)
� max. 12" x 18" (305 x 457 mm)
� Custom sizes must be defined in driver before printing.

Banners: up to 12" W x 47¼" L (305 mm x 1.2 m)

Transparencies: letter or A4

Takes 250 sheets 20 lb. US Bond (75 g/m2) paper
100 transparencies
25 envelopes
stack of label sheets approx. 1" (2.5 cm) high
21



Print Media Settings
by Type
Paper

Sizea

a. Media type = Plain, Media weight = 17 to 57 lb. US Bond

Feed Tray, Exit Trayb

b. Face-Down = top exit tray (see page 36);
Face-Up = straight-through, side exit tray (see page 37)

Letter, Legal-13/13.5/14,  Executive, Tabloid, Tabloid 
Extra, A3, A3 Wide, A3 Nobi, A4, A5, B4, B5

All Trays,
Face-Down (up to 47 lb.) or 
Face-Up (up to 57 lb.)

A6 Tray 1 or MP Tray,
Face-Up only

Customc:  min. 4.1" x 5.8", max. 12" x 18"

c. Define in the printer driver before using.

Tray 1, Face-Up only

Customc: min. 5.8" x 8.3", max. 12" x 18" Trays 2 to 5, Face-Up only

Customc: min. 3"  x 5", max. 12" x 18"
Banners to 47¼", max. 34 lb. US Bond

MP Tray, Face-Up only
22



Print Media Settings
by Type
Labels, Transparencies, Envelopes 

Media Media Size Media Typea

a. Media Weight = not applicable.

Feed Tray

Exit Trayb

b. Face-Down = top exit tray (see page 36);
Face-Up = straight-through, side exit tray (see page 37)

Labels Letter or A4 N.A.c

c. N.A. = not applicable.

MP Tray only
Face-Up only

Transparencies Letter or A4 Transparency Tray 1 or MP Tray
Face-Up only

Envelopes COM-10 Envelope N.A. MP Tray only
Face-Up only
23



Print Media Settings
by Type
Thick Paper (Cards, Index, etc.)  

Sizea

a. Media type = Plain.

Media Weight, Index Feed Trayb

b. Thick paper: use the face-up exit (see page 37).

Letter, Legal-13, Legal-13.5, 
Legal-14, Executive, Tabloid, Tabloid 
Extra, A3, A3 Wide, A3 Nobi, A4, A5, 
B4, B5

up to 119 lb. Any Tray

up to 166 lb. MP Tray only

Customc: min. 4.1" x 5.8"

c. Maximum 12" x 18". must be defined in driver before printing.

up to 119 lb. Tray 1

Customc: min. 5.8" x 8.3" up to 119 lb. Trays 2 to 4

Customc: min. 3" x 5" up to 166 lb. MP Tray

Banners up to 12" x 47¼" up to 71 lb. MP Tray
24



Print Media
Recommended
Media Type Recommended

Paper Letter:

� OKI® Bright White, 32-lb. US Bond (see page 31)
� OKI Banner Paper, 70 lb., (see page 31)

� HammerMill® Laser Print Radiant, White, 24-lb. US Bond

� Xerox® 4024, 20-lb. US Bond
Tabloid/Tabloid Extra:

� OKI Bright White, 32-lb. US Bond (see page 31)
� HammerMill Laser Print Radiant, White, 24-lb. US Bond

Labels Letter: Avery® 5161; A4: Avery 7162, 7664, 7666

Transparencies Letter:
� OKI 52205701 (see page 31)

� 3M® CG3720

Envelopes COM-10: OKI 52206301, 52206302 (see page 31)

Thick Letter:
� OKI 52205601 series Card Stock (see page 31)
� Wausau Exact Index: 49108 (90-lb.) or  49508 (110-lb.)
25



Print Media Types
Paper
For more information, see page 22.

Do not use
� Heavily coated, glossy, or smooth 

paper
� Embossed, rough, or heavily 

textured paper
� Recycled paper
� Paper with cutouts, perforations, or 

excessive paper dust.

Sample Ream Label

1 Media Weight, US Bond
2 Media Weight, Metric

1

2

ReamLabel1.bmp
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Print Media Types
Labels
For more information, see page 23.

Caution!
Use labels designated for laser 
printers. Labels must cover the 
entire carrier sheet. The adhesive 
must not be exposed.

Individual Print Jobs
Select the following settings in the 
driver:
� Source = MP Tray
� Size = Letter long, Letter short, A4 

Long edge, A4 Short edge
� Type = Labels
� Media Size = Off: Windows® 

Adobe® PostScript® only:
Windows XP / 2000
Printing Preferences →  Advanced 
→ Document Options → Printer 

Features

Windows Me/98/95
Properties → Setup tab → Paper 
Feed Options

All Print Jobs (Make Labels 
the Default)

Set the printer menu:
Press ENTER to switch to the Menu 
mode.
Menus → Tray Configuration → MP Tray 
Config → 
� Paper Size → Choose Letter Long Edge, 

Letter Short Edge, A4 Long Edge, or A4 
Short Edge

� Media Type → Labels
� Media Weight → Choose Heavy, Ultra 

Heavy1, Ultra Heavy2, or Ultra Heavy3 
(see page 17).
27



Print Media Types
Transparencies
For more information, see page 23

Caution!
Avoid office transparencies 
designed for use by hand with 
marker pens. These will melt in the 
fuser and cause damage.

Individual Print Jobs
Select the following settings in the 
driver:
� Source = Tray 1 or MP Tray
� Size = Letter  long, Letter short, 

A4 Long edge, A4 Short edge
� Type = Transparency
� Media Size = Off: Windows® 

Adobe® PostScript® only (see page 
27).

All Print Jobs (Make 
Transparencies the 
Default)

Set the printer menu:
Press ENTER to switch to the Menu 
mode.
For Tray 1
Menus → Tray Configuration → Tray1 
Config → Media Type → Transparency.
For MP Tray
Menus → Tray Configuration → MPTray 
Config → 
� Paper Size → Choose Letter Long Edge, 

Letter Short Edge, A4 Long Edge, or A4 
Short Edge

� Media Type → Transparency
28



Print Media Types
Envelopes
For more information, see page 23

Important!
For the best print results, use only 
the recommended envelopes (see 
page 25).
Never use envelopes with metal 
clasps, snaps, windows, or V-flap 
seals: 

Individual Print Jobs
Select the following settings in the 
driver:
� Source = MP Tray
� Size = COM-10

All Print Jobs (Make 
Envelopes the Default)

Set the printer menu:
Press ENTER to switch to the Menu 
mode.
Menus → Tray Configuration → MPTray 
Config → Paper Size → COM-10 Envelope 
LEF.Envelopes.jpg
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Print Media Types
Thick Paper
For more information, see page 24

Caution!
To prevent damage to the printer, it 
is very important to check the 
printer�s media settings before 
printing on thick paper.

Individual Print Jobs
Select the following settings in the 
driver:
� Media Type = Medium Heavy, 

Heavy, Ultra Heavy 1, Ultra Heavy 
2, or Ultra Heavy 3.

Note: See page 17 for more 
information on weight 
designations.

All Print Jobs: (Make Thick 
Paper the Default)

Set the printer menu:
Press ENTER to switch to the Menu 
mode.
Tray 1, 2, 3, 4, or 5
Menus → Tray Configuration →
TrayZ Config → Media Weight →
Choose Medium Heavy, Heavy, Ultra Heavy1 
or Ultra Heavy2.
MP Tray
Menus → Tray Configuration →
MPTray Config → Media Weight →
Choose Medium Heavy, Heavy, Ultra Heavy, 
Ultra Heavy2, or Ultra Heavy3.
30
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To purchase Oki Media, contact your 
dealer or visit http://my.okidata.com.

Bright White Proofing Paper
� 32-lb. US Bond  

Banner Paper*†

� 70 lb. Text, white, 12.9" x 35.4"
� P/N 52206001, Box of 100

SynFlex�*†

� Waterproof, Tear Resistant 
� White, 8½" x 11"
� P/N 52205901, Box of 100

Premium Color Transparencies
� Letter Size
� P/N 52205701, Box of 50

Premium Envelopes*†

� COM-10
� Security tint, Redi-Strip seal
� P/N 52206301, Box of 100 

Premium Card Stock*†

� Acid-free, white, 8½" x 11" 

* For best print results:
Temperature = 65 to 77°F
Humidity = 40 to 65% RH

� MP Tray only

Oki Part # Size Qty

52206101 8½ x 11'' 500/pack

52206102 11 x 17'' 500/pack

52206103 12 x 18'' 500/pack

Oki Part # Weight Qty

52205601 60-lb. Cover 250/box

52205602 90-lb. Index 250/box

52205603 110-lb. Index 250/box

Print Media Types
Oki Print Media



Loading Print Media
Trays 1-5
For more information, see the on-line 
User's Guide on the Docu-mentation 
CD provided with your printer or at 
http://my.okidata.com.

1

2

3 Print side down:

Note: For Letterhead stationery:

Long edge feed�face 
down, top toward the 
back of the printer.

Short edge feed�
face down, top to 
the right:

C96_RearPaperStopper.jpg

fan_paper_F2_10.jpg

C96_LoadPaperT
ray1_rev.jpg

Letr_lef.bmp

ltrhjd_se.bmp
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Loading Print Media
MP Tray
For more information, see the on-line 
User's Guide on the Docu-mentation 
CD provided with your printer or at 
http://my.okidata.com.

1

2

3

4 Print side up.

ES2640e 
MFP 
75.jpg

ES2640e MFP 76.jpg

fan_paper_F2_10.jpg

ES3640e MFP 77.jpg
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Loading Print Media
MP Tray
Note: Letterhead Stationery (Letter, 
A4 or B5):

Long edge feed�aim top toward 
the back of the printer:

Short edge feed�aim the top 
into the printer:

Note: Transparencies & Labels:

� Print side up.
� Default = long edge feed.

Envelopes:
� Flap side down, aimed into 

the printer:

manl_le.jpg

manl_se.jpg

C96_LoadPa
perMPTray_L
abels_crop.j
pg

C96_LoadP
aperMPTray
_Envelopels
_crop.jpg
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Loading Print Media
Changing the MP Tray Default
Check the Media Size
Default = Letter Long Edge

1. Press ENTER.
2. ∇/ ∆ keys →  Menus.  Press ENTER.
3.Highlight Tray Configuration.  Press 

ENTER.
4. ∇/ ∆ keys → MP Tray  Config. Press 

ENTER.
5. ∇/ ∆ keys → Paper Size.  Press 

ENTER.
6. ∇/ ∆ keys → appropriate size 

(labels and transparencies:  only 
Letter or A4). Press ENTER..

7.Set the Media Type 
(transparencies) or Media Weight 
(labels, etc.), as described below.

Set Media Type: Transparencies
1. ∇/ ∆ keys → Media Type. Press 

ENTER.
2. ∇/ ∆ keys → Transparency.  Press 

ENTER.
3. Press ON LINE to exit the Menu 

mode.

Set  Media Weight: 
Labels, Thick Paper, etc.
1. ∇/ ∆ keys → Media Weight. Press 

ENTER.
2. ∇/ ∆ keys → appropriate media 

weight (see page 17). Press ENTER.
3. Press ON LINE to exit the Menu 

mode.
35



Printer Exit Paths
Face Down (Top)
This is the tray that is normally used. The tray holds up to 500 sheets of 
20-lb. (75 g/m2) paper.

The Face-Up exit tray (see next page) 
must be used for special media or for 
heavy papers.

ES3640e MFP 81.jpg
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Printer Exit Paths
Face Up (Side)
The side (face-up) exit tray provides a 
straight-through print path.  Use the 
straight-through path when printing, 
transparencies, labels, heavy card 
stock, or any printing from the MP 
Tray. It holds up to 250 sheets of 
20-lb. (75 g/m2) paper.

Opening the Face-Up Exit Tray

1

2

3

ES3640e MFP 78.jpg

ES3640e MFP 79.jpg

ES3640e MFP 80.jpg
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First the document is assigned a 
password and processed to a print file 
which is saved on the hard disk drive 
(see the on-line User's Guide on the 
Documentation CD provided with your 
printer or at my.okidata.com.)
To print the document, you must go to 
the printer and enter a password. 

To Print the Document
1. Press ENTER.
2. ∇/ ∆ keys → Print Secure Job. Press 

ENTER.
3.Use the ∆ and ∇ keys to scroll to 

the number for the first digit in 
your password. Press ENTER.

4.Repeat the previous step for each 
digit in the password.

5. Press ENTER.
6.Highlight Print. Press ENTER.

7.Use the ∇/ ∆ keys to enter the 
value for Set Collating Amount. Press 
ENTER.

Secure Print: The document 
prints. It is deleted from the 
HDD.
Store to HDD: The document 
prints. It remains stored until 
you delete it.

8. The printer goes on line.

To Delete the Document
1. Follow steps 1 through 5 above.
2. ∇/ ∆ keys → Delete. Press ENTER.
3.Select Yes to confirm the deletion.
4. Press ENTER.

The printer goes on line.

Secure Print & Store to Hard Disk Drive



The Printer Control Panel
Keys
SHUT DOWN/RESTART

Hold down for more than four (4) 
seconds for a soft shutdown.
You can either restart the printer or 
turn it off:
� Restart: press the button again.
� Turn off: use the on/off (power) 

switch.

BACK

Press to go back to the previous item 
or category.
Up Arrow (∆)
Press to go to the previous category 
or item in the menu.
Down Arrow (∇)
Press to enter the menu mode, or to 
go to the next category or item in the 
menu.

control_panel_no_callouts.jpg control_panel_no_callouts.jpg
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The Printer Control Panel
Keys
ENTER

Press to engage the menu item shown 
on the display. An Asterisk (*) 
appears next to the selected item.
ON LINE

Press to save any menu changes and 
place the printer back on-line (Ready 
to Print).
CANCEL

Press to cancel the current print job.

HELP

Press to provide additional 
instructions for the error condition 
which appears on the display.

control_panel_no_callouts.jpg
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READY

On
The printer is on line.

Off
The printer is off line.

Flashing
The printer is receiving data.

ATTENTION

On
Warning!
The printer needs attention, but will 
continue to operate. An error message 
displays:  Toner Low, Paper Near End, etc.

Off
Normal.

Flashing
Alarm!
The printer needs attention 
immediately. An error message 
displays: Paper Jam, Tray1 Empty, etc.

control_panel_no_callouts.jpg

The Printer Control Panel
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Power Save sets how long the printer 
waits before going into standby mode 
(default = 60 min). This saves energy, 
but the printer requires time to warm 
up when it receives a print job or if 
you want to enter the menu and 
change settings.

Set the Time Interval 
1. Press ENTER.
2.Use the ∇ key to scroll down to 

Menus.  Press ENTER.
3. ∇/ ∆ keys → System Adjust. Press 

ENTER.
4.Highlight Power Save Time. Press 

ENTER.
5. ∇/ ∆ keys → select the time 

interval.  Press ENTER.
6. Press ON LINE to exit the Menu 

mode.

Disable Printer Power Save
1.Press ENTER.
2. ∇/ ∆ keys → Admin Setup. Press 

ENTER.
3. ∇/ ∆ keys → Yes. Press ENTER.

Offline appears on the display.
4.Wait for Setup to run.

The Setup menu appears.
5. ∇/ ∆ keys → Printer Setup. Press 

ENTER.
6.Keep pressing ENTER repeatedly 

until Power Save appears.
7. ∇/ ∆ keys → Disable. Press ENTER.
8. Press ON LINE.
9. Press ENTER to select Exit Setup.

10.Wait for the printer to initialize.

Printer Power Save Mode



Clean the printer�s LED head(s)
� when you install a new toner 

cartridge.
� if the printed sheets show signs of 

faded images, white stripes, or 
blurred letters.

The scanner unit shelf includes 
hydraulics to assist in moving the 
shelf up and down.
NEVER OPERATE THE RELEASE 
HANDLE (2) ON THE RIGHT SIDE OF 
THE SHELF WITHOUT THE SCANNER 
BOLTED TO THE SHELF.

1.Place one hand firmly on the front 
handle (1) of the scanner shelf, 
then carefully press the release 
handle (2) so that the shelf lifts 
out of the way.

ES3640e MFP 85.jpg
Cleaning the Printer LED Heads
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Cleaning the Printer LED Heads
2.Open the top cover about half way. 
This allows access to the LED 
heads.

3.Use the lens cleaner supplied with 
the toner cartridges (or a clean, 
soft cloth) to gently clean the LED 
heads (1).

C96_Clean_LEDs1_CROP.jpg
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Cleaning the Printer LED Heads
4.Close the printer cover. TO PREVENT ANY 
POSSIBLE CRUSHING 
OF FINGERS, KEEP 
YOUR HANDS AWAY 
FROM THE POSTS AT 
THE BACK OF THE 
SCANNER STAND 
WHEN MOVING THE 
SHELF DOWN.

5.Place one hand firmly on the front 
handle of the scanner shelf, then 
press the release handle and 
carefully lower the scanner shelf, 
making sure it locks in place.
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Printing Reports

Note: To print the Job Log or Color 
Chart reports, tabloid paper 
must be loaded in Tray 1.

1. Press ENTER.
2. ∇/ ∆ keys → Print Pages. Press 

ENTER.
3. ∇/ ∆ keys → report you wish to 

print:
� PS Test Page: provides a list of the 

Fiery PostScript settings and 
sample color swatches.

� Configuration: general information 
on your printer�s configuration, 
plus a listing of the current menu 
settings.

� Job Log: prints the Job 
Accounting software log. See the 
Utilities Guide (on the 
Documentation CD supplied with 
your printer) for more 
information.

� Color Charts: prints Pantone®, 
CMY and RGB color charts.

� PS Font List: PostScript fonts in 
the printer.

� PCL Font List: PCL fonts in the 
printer.

� Demo Page: prints the Demo page.
� E-mail Log: lists data on emails, 

including Status, From, To, Date, 
Time, Subject, etc.

� Error Log: list of errors which have 
occurred.

4. Press ENTER.
The report prints and the printer 
goes back on line.

Control Panel 
Right Side.jpg

Printer Reports
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The printer has a built-in help system.

When an error message appears on 
the printer display, press HELP. The 
display shows information that will 
help you correct the error.

Use the ∇/ ∆ keys to move through the 
Help information.

For more information, see the on-line 
User's Guide on the Docu-mentation 
CD provided with your system or at 
http://my.okidata.com.

C96_Help.jpg

Printer Error Messages
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If you are experiencing frequent paper 
jams, check the following.
� Is the printer level?
� Is the media you are using within 

specification (see pages 17 through 
25)? Media that is too light or too 
heavy will often cause jams.

� Are the settings (printer and driver) 
appropriate for the media being 
used (see pages 17 through 24)? 

� Do not used creased or curled 
media.

� Remove the media from the tray.  
Fan/ align the stack.  Replace the 
media.

� Envelopes are jamming.  Make sure 
the stack is properly aligned. 
Envelopes must be loaded flap 
down, top edge toward the printer.   

� Clean the feed rollers: for more 
information, see the on-line User's 
Guide on the Documentation CD 
provided with your printer or at 
http://my.okidata.com.

fan_paper_
F2_10.jpg
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Printer Media Jams



� Consult the dealer where you 
purchased your system.

� Visit

myokidata.jpg
Service and Support
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OKI is a registered trademark of Oki Electric Industry Company, Ltd. 
3M is a trademark or registered trademark of 3M. 
Adobe, and PostScript are trademarks of Adobe Systems, Inc. which may be 
registered in certain jurisdictions.
AMEX is a registered trademark of American Express Co.
HammerMill is a registered trademark of HammerMill.
MasterCard is a registered trademark of MasterCard International, Inc.
The Pantone trademark is the property of Pantone, Inc.
VISA is a registered trademark of Visa.
Xerox is a trademark of Xerox Corporation.
Wausau Exact is a registered trademark of Wausau-Mosinee Paper Corp.
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